
  2002 Microchip Technology Inc.  DS51303A

TC74 Serial Temperature Sensor
Demo Board User’s Guide



DS51303A - page ii   2002 Microchip Technology Inc.

Information contained in this publication regarding device
applications and the like is intended through suggestion only
and may be superseded by updates. It is your responsibility to
ensure that your application meets with your specifications.
No representation or warranty is given and no liability is
assumed by Microchip Technology Incorporated with respect
to the accuracy or use of such information, or infringement of
patents or other intellectual property rights arising from such
use or otherwise. Use of Microchip’s products as critical com-
ponents in life support systems is not authorized except with
express written approval by Microchip. No licenses are con-
veyed, implicitly or otherwise, under any intellectual property
rights.

Trademarks

The Microchip name and logo, the Microchip logo, KEELOQ,

MPLAB, PIC, PICmicro, PICSTART and PRO MATE are

registered trademarks of Microchip Technology Incorporated

in the U.S.A. and other countries.

FilterLab, microID, MXDEV, MXLAB, PICMASTER, SEEVAL

and The Embedded Control Solutions Company are

registered trademarks of Microchip Technology Incorporated

in the U.S.A.

dsPIC, dsPICDEM.net, ECONOMONITOR, FanSense,

FlexROM, fuzzyLAB, In-Circuit Serial Programming, ICSP,

ICEPIC, microPort, Migratable Memory, MPASM, MPLIB,

MPLINK, MPSIM, PICC, PICDEM, PICDEM.net, rfPIC, Select

Mode and Total Endurance are trademarks of Microchip

Technology Incorporated in the U.S.A. and other countries.

Serialized Quick Turn Programming (SQTP) is a service mark

of Microchip Technology Incorporated in the U.S.A.

All other trademarks mentioned herein are property of their

respective companies.

© 2002, Microchip Technology Incorporated, Printed in the

U.S.A., All Rights Reserved.

 Printed on recycled paper.

Microchip received QS-9000 quality system 
certification for its worldwide headquarters, 
design and wafer fabrication facilities in 
Chandler and Tempe, Arizona in July 1999 
and Mountain View, California in March 2002. 
The Company�s quality system processes and 
procedures are QS-9000 compliant for its 
PICmicro® 8-bit MCUs, KEELOQ® code hopping 
devices, Serial EEPROMs, microperipherals, 
non-volatile memory and analog products. In 
addition, Microchip�s quality system for the 
design and manufacture of development 
systems is ISO 9001 certified.

Note the following details of the code protection feature on Microchip devices:

� Microchip products meet the specification contained in their particular Microchip Data Sheet.

� Microchip believes that its family of products is one of the most secure families of its kind on the market today, when used in the 

intended manner and under normal conditions.

� There are dishonest and possibly illegal methods used to breach the code protection feature. All of these methods, to our knowl-

edge, require using the Microchip products in a manner outside the operating specifications contained in Microchip's Data 

Sheets. Most likely, the person doing so is engaged in theft of intellectual property.

� Microchip is willing to work with the customer who is concerned about the integrity of their code.

� Neither Microchip nor any other semiconductor manufacturer can guarantee the security of their code. Code protection does not 

mean that we are guaranteeing the product as �unbreakable.�

Code protection is constantly evolving. We at Microchip are committed to continuously improving the code protection features of our

products.



  2002 Microchip Technology Inc. DS51303A-page iii

TC74 Serial Temperature Sensor

Demo Board User�s Guide

Table of Contents

Chapter 1.   General Information

1.1 Introduction ..................................................................................... 1

1.2 The TC74 Demo Board ................................................................... 2

1.3 TC74 Board Applications ................................................................ 3

1.4 Reference Documents .................................................................... 3

Chapter 2.   Getting Started

2.1 TC74 Software Installation and Menu Options ............................... 5

2.2 Hardware Installation ...................................................................... 8

2.3 Implementing the TC74 .................................................................. 8

Appendix A.   Board Layout

A.1 Introduction ..................................................................................... 9

A.2 Board Layout and Schematic  ......................................................... 9

A.3 Demo Board Components ............................................................. 10

A.4 TC74 Functional Block Diagram ................................................... 10

Worldwide Sales and Service ............................................................................. 12



TC74 Serial Temperature Sensor Demo Board User�s Guide

DS51303A-page iv   2002 Microchip Technology Inc.

NOTES:



  2002 Microchip Technology Inc. DS51303A-page 1

TC74 Serial Temperature Sensor

Demo Board User�s Guide

Chapter 1. General Information

1.1 INTRODUCTION

Thank you for purchasing the TC74 Serial Temperature Sensor Demo Board from 

Microchip Technology Inc. The TC74 Demo Board is an evaluation and demonstration 

board specifically designed to support Microchip�s TC74, a 2-wire serial temperature 

sensor. Communication with the TC74 is accomplished with a PC running the 

communication software.

The evaluation board and software for the TC74 have been designed specifically for 

use with a PC running Windows® 95 and an available parallel port. 

The TC74 Demo Board has the following features:

1. A TC74A5-5.0VCT device.

2. Parallel port for power and communication.

3. 3/4� x 2 1/2� circuit board allows �real-world� evaluation and design.

4. Footprint for temperature-to-voltage IC.

5. Printer port connector (female).

6. Unpopulated holes for pull-up resistors.

7. Unpopulated holes for thermistor (comparative evaluation). 
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1.2 THE TC74 DEMO BOARD

The TC74 Demo (Figure 1-1) is built on a 3/4 inch by 2 1/2 inch PC board featuring 

easy setup for bench top evaluation and testing. The board is powered directly from the 

PC printer port.

The TC74 Demo Kit comes with the following:

1. TC74 Demo Board 

2. TC74A5-5.0VCT (sample on PCB)

3. TC74 Serial Temperature Sensor Demo Board User�s Guide (DS51303)

4. TC74 Data Sheet (DS21462)

5. TC74 Communication Software

The following must be provided by the user to implement a TC74 system.

1. Centronics Port Printer Cable.

If any item is damaged or missing, please contact your nearest Microchip sales office 

listed on the back of this publication.

FIGURE 1-1:  TC74 Serial Temperature Sensor Demo Board
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1.3 TC74 DEMO BOARD APPLICATIONS

The TC74 Demo Board is the ideal solution for identifying the temperature profile of 

applications, such as, datacom, telecom and PC equipment. Simply let your equipment 

run under normal operating conditions, record temperature data in wide time intervals 

and save the resulting data in a file. 

The following are appropriate applications for the TC74 Demo Board:

1. Thermal protection for hard disk drives and other PC peripherals.

2. PC card devices for notebook computers.

3. Real-time temperature measurement for datacom and telecom equipment. 

4. Low cost thermostat controls.

5. Thermistor replacement.

1.4 REFERENCE DOCUMENTS

Other Reference Documents may be obtained by contacting your nearest Microchip 

sales office (listed on the back of this document) or by visiting the Microchip website at 

(www.microchip.com).

� Technical Library CD-ROM, (DS00161), or the individual data sheet:

- TC74 Data Sheet, (DS21462)

� Analog & Interface Families Data Book 2002, (DS00207)

� 2002 Technical Documentation Analog & Interface Product Families CD-ROM, 

(DS51205)

� Serial Output Temperature Sensor Family Sell Sheet, (DS21651)

� TC74 Demo Board Kit Sell Sheet, (DS51253)
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Chapter 2. Getting Started

This chapter discusses the necessary steps for installing the software, understanding 

the various menu options and installing the hardware components. Additionally, it 

explains how to implement the TC74 Demo Board. Before getting started, please 

check the contents you received against the TC74 Demo Board Packing List. Also, 

please read section 1.2� "The TC74 Demo Board", in Chapter 1 for a list of what is 

included in the TC74 kit and what you must provide. Assemble the necessary items.

2.1 TC74 SOFTWARE INSTALLATION AND MENU OPTIONS

You can either download the TC74 software via the Internet or download it from the 

TC74 installation disk. 

1. First create a directory for the evaluation software to reside in, such as,

 \Program Files\Microchip.

2. Next, use pkunzip (or any other readily available decompressing software) to 

extract the software from TC74EV.ZIP to the directory that was created.

3. Finally, the software can be launched by double clicking on the TC74.EXE file 

from the Microsoft® Windows® Explorer Start Menu or File Manager.

2.1.1 Software Screen Menus

This section gives a brief description of the various menu commands and features 

associated with the TC74 software. See Figure 2-1.

FIGURE 2-1: TC74 Serial Temperature Sensor Software, Sample Screen
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2.1.1.1 FILE MENU COMMANDS

The file menu offers the following commands:

1. Save

Saves the current group of temperature samples to a file.
2. Save As

Saves the current group of temperature samples to a user supplied file name.

3. Exit

Exits the TC74 software.

4. File Save / File Save As 

Use this command to save the current group of temperature readings to a file.

5. Exit Command 

Use this command to end your TC74 session. You can also use the Close 

command on the application�s control menu.

Shortcuts:

Mouse: Double-click the application�s control menu button.

Keys: ALT+ F4

2.1.1.2 LPT PORT MENU COMMANDS

The LPT Port menu is used to specify the address of the parallel port to which the TC74 

board is connected. The three most common addresses are shown as menu selections. 

The currently selected port is also stored in the system registry and automatically resets 

when the software is restarted.

0X378      Set the LPT port address to 0X378.

0X278      Set the LPT port address to 0X278.

0X278      Set the LPT port address to 0X278.

2.1.1.2.1 Custom Command

If the parallel printer port address is not displayed in the menu, use the Custom option to 

set the address. Enter three hexadecimal characters. Do not preface the number with 

any extra formatting characters. Use extreme caution. If the address is set incorrectly, it 

may be necessary to reboot the computer. It is not recommended that this address be set 

arbitrarily.

2.1.1.2.2 How to find the LPT Port Address

1. Double click the My Computer icon on your desktop.

2. Open the Control Panel and then double click the System icon.

3. Click on the Device Manager tab.

4. Expand the Ports (COM & LPT) entry by double clicking it.

5. Highlight the correct LPT port and then click the Properties button.

6. Click on the Resources tab.

7. Make a note of the Setting for the Input/Output Range. The first number in that 

range is the address of the port.

2.1.1.3 SMBus� BUS ADDRESS

The SMBus� address of the TC74 chip must be set by selecting the appropriate 

address from the menu options. The SMBus address is also stored in the system reg-

istry and reset whenever the software is restarted. The SMBus address is not config-

urable on the evaluation board but is a factory programmable option. The software 

defaults to the standard SMBus address used by the TC74 silicon.
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2.1.1.4 HELP MENU COMMANDS

The Help menu offers the following commands which provide assistance with this 

application: 

1. Help Topics

Provides an index to topics on which to get assistance.

2. About

Displays the version number of this application.

3. Index Card

Use this command to display the opening screen of Help. From the opening 

screen you can go to step-by-step instructions for using the TC74 software and 

to access various types of reference information. Once you open Help, you can 

click the Contents button whenever you want to return to the opening screen.

4. About Command

Use this command to display the copyright notice and version number of your 

copy of the TC74 software.

2.1.1.5 ON/OFF BUTTON

The TC74 Demo Board is powered directly from the computer�s parallel port, therefore, 

the software power button must be clicked on in order to power and establish 

communication with the board. If clicking on the power button results in an error 

message, make sure that the serial bus address and parallel port address have been 

set properly.

2.1.1.6 CONFIGURATION REGISTER

The contents of the Temperature register are non-programmable. This is a read-only 

register.

The Configuration Register has only one writable bit. Bit 7 (standby mode) can be 

toggled by clicking the corresponding check box. Bit 6 indicates that a sample is ready 

and is read-only. All other bits read back as zero.

2.1.1.7 THE TEMPERATURE GAUGE

The temperature gauge is to the left of the temperature graph and uses the same 

vertical scale as the graph. It displays the current value of the temperature register.

2.1.1.8 THE TEMPERATURE GRAPH

The temperature graph plots the last 100 readings of the temperature register. The 

graph is reset whenever the On/Off power switch is clicked On or the Clear Graph 

button is clicked.

A new point is graphed when the temperature register Read button is clicked or when 

the software makes a timed read of the Temperature register during looped read mode. 

The current set of graphed readings can be saved at any time from the File Menu.

2.1.1.9 LOOP BUTTON

To automatically read the temperature on an ongoing basis, click the Loop button. This 

displays a dialog box that asks how often the software should read the temperature 

register. Positive values up to 18 hours are allowed. A value of 0 hrs, 0 min and 0s will 

be converted to 1 second. The temperature graph will be updated each time the 

temperature register is read. To stop the automatic loop read, click the Stop button 

(displayed only during looping mode).
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2.2 HARDWARE INSTALLATION

Connect the Centronics connector on the evaluation board to an available parallel port 

on your computer, using a standard printer cable (cable not included with the TC74 kit). 

The evaluation board is powered directly from the parallel port and therefore no 

external power connection is required.

2.3 IMPLEMENTING THE TC74

To get started with the TC74, launch the software from the Windows® 95 start menu.

The LPT Port menu allows the user to specify the address of the parallel port to which  

the TC74 board is connected. The three most common addresses are shown as menu 

selections:

0X378       Set the LPT port address to 0X378.

0X278       Set the LPT port address to 0X278.

0X3BC      Set the LPT port address to 0X3BC.

Custom    Advanced feature that allows you to enter a different address.

To power-up the board and to start reading temperature data, simply click the �Board 

Power� button. The temperature will be displayed in the temperature register and on 

the thermometer and temperature graph.

To automatically read the temperature on an ongoing basis, click the Loop button. This 

displays a dialog box that asks how often the software should read the temperature 

register. Non-negative values up to 18 hours are allowed. A value of 0 hours, 0 minutes 

and 0 seconds will be converted to 1 second.

The temperature graph will be updated each time the temperature register is read. To 

stop the automatic loop read, click on the Stop button.

The contents of the temperature register are non-programmable. This is a read-only 

register. The configuration register has only one writable bit. Bit 7 (Standby Mode) can 

be toggled by clicking the corresponding check box.
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Appendix A. Board Layout

A.1 INTRODUCTION

This appendix contains general information concerning the layout, schematic and 

components for the TC74 Demo Board.

A.2 BOARD LAYOUT AND SCHEMATIC

FIGURE A-1: TC74 Demo Board Layout and Schematic
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A.3 DEMO BOARD COMPONENTS

Table A-1 lists the components that the TC74 board consists of and their associated 

values assigned.

TABLE A-1: TC74 BOARD COMPONENTS AND VALUES

A.4 TC74 FUNCTIONAL BLOCK DIAGRAM

The diagram pictured in Figure A-2 shows the TC74 powered directly to a PC running 

the communication software.

FIGURE A-2: TC74 Functional Block Diagram

Component Component Values

R1 Pull-up Resistor - Not populated

R2 Pull-up Resistor - Not populated

C2 .1 µF Capacitor

U1 TC74A5-5.0VCT Device

D1 IN4148 diode or 1N914

U3 Thermistor - Not populated

DB1 Printer Port Connector - Female

To PC DB36-F

TC74

VDD

GND

SCL

SDA
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	Numbered - 3. Exit Exits the TC74 software.
	Numbered - 4. File Save / File Save As Use this command to save the current group of temperature ...
	Numbered - 5. Exit Command Use this command to end your TC74 session. You can also use the Close ...
	Body - Shortcuts:
	Body - Mouse: Double-click the application’s control menu button.
	Body - Keys: ALT+ F4
	Heading3 - 2.1.1.2 LPT Port Menu Commands
	Body - The LPT Port menu is used to specify the address of the parallel port to which the TC74 bo...
	Body - 0X378 Set the LPT port address to 0X378.
	Body - 0X278 Set the LPT port address to 0X278.
	Body - 0X278 Set the LPT port address to 0X278.
	Heading4 - 2.1.1.2.1 Custom Command
	Body - If the parallel printer port address is not displayed in the menu, use the Custom option t...
	Heading4 - 2.1.1.2.2 How to find the LPT Port Address
	Numbered1 - 1. Double click the My Computer icon on your desktop.
	Numbered - 2. Open the Control Panel and then double click the System icon.
	Numbered - 3. Click on the Device Manager tab.
	Numbered - 4. Expand the Ports (COM & LPT) entry by double clicking it.
	Numbered - 5. Highlight the correct LPT port and then click the Properties button.
	Numbered - 6. Click on the Resources tab.
	Numbered - 7. Make a note of the Setting for the Input/Output Range. The first number in that ran...
	Heading3 - 2.1.1.3 SMBus™ Bus Address
	Body - The SMBus™ address of the TC74 chip must be set by selecting the appropriate address from ...
	Heading3 - 2.1.1.4 Help Menu Commands
	Body - The Help menu offers the following commands which provide assistance with this �application:
	Numbered1 - 1. Help Topics Provides an index to topics on which to get assistance.
	Numbered - 2. About Displays the version number of this application.
	Numbered - 3. Index Card Use this command to display the opening screen of Help. From the opening...
	Numbered - 4. About Command Use this command to display the copyright notice and version number o...
	Heading3 - 2.1.1.5 On/Off Button
	Body - The TC74 Demo Board is powered directly from the computer’s parallel port, therefore, the ...
	Heading3 - 2.1.1.6 Configuration Register
	Body - The contents of the Temperature register are non-programmable. This is a read-only register.
	Body - The Configuration Register has only one writable bit. Bit 7 (standby mode) can be �toggled...
	Heading3 - 2.1.1.7 The Temperature Gauge
	Body - The temperature gauge is to the left of the temperature graph and uses the same �vertical ...
	Heading3 - 2.1.1.8 The Temperature Graph
	Body - The temperature graph plots the last 100 readings of the temperature register. The graph i...
	Body - A new point is graphed when the temperature register Read button is clicked or when the so...
	Heading3 - 2.1.1.9 Loop Button
	Body - To automatically read the temperature on an ongoing basis, click the Loop button. This dis...
	tablenote - 
	Heading1 - 2.2 Hardware Installation

	Body - Connect the Centronics connector on the evaluation board to an available parallel port on ...
	Heading1 - 2.3 Implementing the TC74

	Body - To get started with the TC74, launch the software from the Windows® 95 start menu.
	Body - The LPT Port menu allows the user to specify the address of the parallel port to which the...
	Body - 0X378 Set the LPT port address to 0X378.
	Body - 0X278 Set the LPT port address to 0X278.
	Body - 0X3BC Set the LPT port address to 0X3BC.
	Body - Custom Advanced feature that allows you to enter a different address.
	Body - To power-up the board and to start reading temperature data, simply click the “Board Power...
	Body - To automatically read the temperature on an ongoing basis, click the Loop button. This dis...
	Body - The temperature graph will be updated each time the temperature register is read. To stop ...
	Body - The contents of the temperature register are non-programmable. This is a read-only registe...
	Appendix - Appendix A. Board Layout
	AppHeading1 - A.1 Introduction

	Body - This appendix contains general information concerning the layout, schematic and components...
	AppHeading1 - A.2 Board Layout and Schematic

	Body - 
	App Figure/AIPD - FIGURE A-1: TC74 Demo Board Layout and Schematic
	AppHeading1 - A.3 demo Board Components

	Body - Table�A-1 lists the components that the TC74 board consists of and their associated �value...
	AppTableTitle - Table A-1: TC74 Board Components and Values

	CellHeading - Component
	CellHeading - Component Values
	CellBody - R1
	CellBody - Pull-up Resistor - Not populated
	CellBody - R2
	CellBody - Pull-up Resistor - Not populated
	CellBody - C2
	CellBody - .1 mF Capacitor
	CellBody - U1
	CellBody - TC74A5-5.0VCT Device
	CellBody - D1
	CellBody - IN4148 diode or 1N914
	CellBody - U3
	CellBody - Thermistor - Not populated
	CellBody - DB1
	CellBody - Printer Port Connector - Female
	AppHeading1 - A.4 TC74 Functional Block Diagram

	Body - The diagram pictured in Figure�A-2 shows the TC74 powered directly to a PC running the com...
	Body - 
	App Figure/AIPD - FIGURE A-2: TC74 Functional Block Diagram
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